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W Introduction

Introduction

Cisco Unified Messaging with IBM Lotus Sametime allows users to view and play Cisco Unity or
Cisco Unity Connection voice messages directly from their Sametime client application.

In addition, IBM Lotus Notes version 8.0.1 and later integrates Sametime features to achieve the
following:

e Sametime shows up in a pane within the Notes client.

e The native capabilities of Sametime—as well as Cisco Unified Messaging with IBM Lotus
Sametime features—can be accessed from within Notes.

System Requirements

Before installing Cisco Unified Messaging with IBM Lotus Sametime, user workstations must meet the
following minimum requirements:

e A supported operating system—see “Client Platforms” in the following section, “Compatibility
Information.”

e 512 MB of RAM.
e 20 MB of free disk space.

¢ One of the following applications:

IBM Lotus Notes version 8.5 or later (including integrated Sametime features)
IBM Lotus Notes version 8.0.1 or later (including integrated Sametime features)
IBM Lotus Sametime version 8.0 or later

IBM Lotus Sametime version 7.5.1 CF1 or later

Compatibility Information

Cisco Unified Messaging with IBM Lotus Sametime is supported for use with the following:

Cisco Unified Messaging Systems

e Cisco Unity

Version 7.0 with IBM Lotus Domino
Version 7.0 with Microsoft Exchange 2007
Version 7.0 with Microsoft Exchange 2003
Version 5.0 with IBM Lotus Domino
Version 5.0 with Microsoft Exchange 2007
Version 5.0 with Microsoft Exchange 2003
Version 4.2 with IBM Lotus Domino
Version 4.2 with Microsoft Exchange 2003

¢ Cisco Unity Connection

Version 7.x
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Related Documentation 1l

— Version 2.x

Client Platforms
e Apple
— Mac OS X 10.5.x (IBM Lotus Sametime version 8.0.1 only)
- Mac OS X 10.4.x (IBM Lotus Sametime version 7.5.1 CF1 and later)
e Microsoft
— Windows Vista Business (MSDN version is not supported.)
— Windows XP (Service Pack 2 or Service Pack 3)
e Novell
— SUSE Linux Enterprise Desktop version 10
— Linux Desktop version 9

e Red Hat Enterprise Linux version 4

IBM Lotus Clients

— IBM Lotus Notes version 8.5 or later (including integrated Sametime features)
— IBM Lotus Notes version 8.0.1 or later (including integrated Sametime features)
— IBM Lotus Sametime version 8.0 or later

— IBM Lotus Sametime version 7.5.1 CF1 or later

Determining the Software Version

To Determine the Cisco Unified Messaging with IBM Lotus Sametime Version in Use

Step 1 From the File menu, select Preferences.
Step2 In the left pane, expand the Cisco tab.
Step3  Under Cisco, select Voicemail.

The Cisco Unified Messaging with IBM Lotus Sametime version is displayed underneath the
“Voicemail” label at the top of the page.

Related Documentation

The User Guide for Cisco Unified Messaging with IBM Lotus Sametime Release 7.x is available at
http://www.cisco.com/en/US/products/ps9830/products_user_guide_list.html.
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New and Changed Requirements and Support—Release 7.1(1)

This section contains information about new and changed requirements and support in the Cisco Unified
Messaging with IBM Lotus Sametime Release 7.1(1) time frame only. Refer to the release notes of the
applicable version for information on new and changed support with earlier versions of the plug-in.
Release notes for all versions of the plug-in are available at
http://www.cisco.com/en/US/products/ps9830/prod_release_notes_list.html.

Versioning of Cisco Unified Messaging with IBM Lotus Sametime Release
7.1(1) Explained

Because other Cisco Unified Communications with IBM Lotus products are versioned 7.1(1), the release
version of Cisco Unified Messaging with IBM Lotus Sametime has been numbered 7.1(1) for
consistency. The previous version was 1.2(3).

Documentation

Translated Versions of User Guide

The User Guide for Cisco Unified Messaging with IBM Lotus Sametime Release 7.x has been translated
into French-France (FRA), German (DEU), Italian (ITA), Japanese (JPN), Spanish-Spain (ESP), and
Swedish (SVE).

The translated guides are available at
http://www.cisco.com/en/US/products/ps9830/tsd_products_support_translated_end_user_guides_list.
html.

New and Changed Functionality—Release 7.1(1)

This section contains information about new and changed functionality for Cisco Unified Messaging
with IBM Lotus Sametime Release 7.1(1) only. Refer to the release notes of the applicable version for
information on new and changed functionality in earlier versions of the plug-in. Release notes for all
versions of the plug-in are available at
http://www.cisco.com/en/US/products/ps9830/prod_release_notes_list.html.

Displaying Additional Voicemail Attributes

Cisco Unified Messaging with IBM Lotus Sametime displays additional attributes for voicemail such as
important and private.

Configuration Tool

The Configuration Tool provides and improved interface for administrators to configure Cisco Unified
Messaging with IBM Lotus Sametime.
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Configuring to Use the Sametime Credentials for End Users

Cisco Unified Messaging with IBM Lotus Sametime can be configured to use the IBM Lotus Sametime
credentials for end users.

Forwarding Voicemail as Email

Cisco Unified Messaging with IBM Lotus Sametime allows users to forward a voicemail as an email.

IMAP IDLE Connections for Access to Voice Messages

Localizations

Cisco Unified Messaging with IBM Lotus Sametime supports IMAP IDLE connections for accessing
voice messages in the following mail stores:

e For Cisco Unity, a mail store that supports the IMAP v4 IDLE command, RFC 2177.

e For Cisco Unity Connection, any supported version.

The graphical user interface (GUI) of Cisco Unified Messaging with IBM Lotus Sametime is translated
into the following languages:

e French

e German
e [talian

e Japanese
e Spanish
e Swedish

Secure Messaging

Cisco Unified Messaging with IBM Lotus Sametime supports the secure messaging feature with
Cisco Unity 7.0(2) and later, and Cisco Unity Connection 7.0(1) and later. The secure messaging feature
provides security for voice messages by using public and private key encryption.

Note that IBM Lotus Sametime version 7.5.1 does not support secure messaging.

Note also that you must extract and apply the IBM hotfix files to support secure messaging. The
“Downloading Cisco Unified Messaging with IBM Lotus Sametime 7.1(1) Software” section on page 6
instructs you at the applicable time. Because IBM hotfixes are not available for IBM Lotus Notes, secure
messaging is not supported for this client at the time of this product. A future version of IBM Lotus
Notes may enable this capability. The IBM hotfixes do not support secure messaging for combinations
of Linux and IBM Lotus Sametime.

For information on how to set up secure messaging, see the applicable documentation:

e For Cisco Unity, see the “Secure Messaging” section in the “Securing Subscriber Messages” chapter
of the applicable Security Guide for Cisco Unity at
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_maintenance_guides_list.html.
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e For Cisco Unity Connection, see the “Secure Messages” section in the “Setting Up Features and
Functionality That Are Controlled by Class of Service” chapter of the applicable User Moves, Adds,
and Changes Guide for Cisco Unity Connection Release 7.x at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/7x/user_mac/guide/7xcucmacx.htm
1.

Installation and Upgrade Information

e Downloading Cisco Unified Messaging with IBM Lotus Sametime 7.1(1) Software, page 6
e Upgrading to Cisco Unified Messaging with IBM Lotus Sametime 7.1(1), page 8

¢ Installing Cisco Unified Messaging with IBM Lotus Sametime 7.1(1), page 8

e Configuring Cisco Unified Messaging with IBM Lotus Sametime 7.1(1), page 9

Downloading Cisco Unified Messaging with IBM Lotus Sametime 7.1(1)

Software

Step 1

Step 2

Step 3
Step 4

Step 5
Step 6
Step 7
Step 8

Step 9

To Download Cisco Unified Messaging with IBM Lotus Sametime 7.1(1)

On the web server that is going to host the update site, create a directory to hold the Cisco Unified
Messaging with IBM Lotus Sametime files.

On a computer with a high-speed Internet connection, go to the Cisco Unified Communications with
IBM Lotus software download page at
http://tools.cisco.com/support/downloads/go/Redirect.x ’mdfid=282224966.

S

Note  To access the software download page, you must be logged on to Cisco.com as a registered user.

On the Select a Release page, expand Latest Releases, then select 7.1(1). The download links appear on
the right side of the page.

Confirm that the computer you are using has sufficient hard disk space for the downloaded files. (The
download file sizes appear below the download links.)

Download the file Cisco_Plugins_7.1.1.zip file to the directory you created in Step 1.
Follow the on-screen prompts to complete the download.
Open the directory you created in Step 1.

From the Cisco_Plugins_7.1.1.zip file, extract the CiscoUMWithLotusST_7.1.1.930.zip file by using
the application appropriate for your operating system.

Open the CiscoUMWithLotusST_7.1.1.930\UpdateSite directory, that was created from the extracted
file.

When extracted, the directory structure for Cisco Unified Messaging with IBM Lotus Sametime looks
like this:

- features
- plugins
- web

index.html
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Step 1

Step 2

Step 1

Step 2

Step 3

Step 4
Step 5

Installation and Upgrade Information

site.xml

To Extract the Cisco Unified Messaging with IBM Lotus Sametime Configuration Tool

Go to the directory where you downloaded the Cisco_Plugins_7.1.1.zip file in the “To Download Cisco
Unified Messaging with IBM Lotus Sametime 7.1(1)” procedure on page 6.

From the Cisco_Plugins_7.1.1.zip file, extract the CiscoCfg-7.1.1.102.zip file by using the application
appropriate for your operating system.

When extracted, the directory structure for the Cisco Unified Messaging with IBM Lotus Sametime
Configuration Tool looks like this:

- ciscocfg
- templates

You must do the following procedure only if secure messaging is configured.

To Apply the IBM Hotfixes (Secure Messaging Only)

On the user workstation, navigate to the CiscoUMWithLotusST_7.1.1.930\UpdateSite\IBM-Hotfixes
directory that was created in the “To Download Cisco Unified Messaging with IBM Lotus Sametime
7.1(1)” procedure on page 6.

Extract the applicable file to this directory by using the application appropriate for your operating
system.

When extracted, the directory structure for the IBM hotfixes looks like this:

- features
- plugins
site.xml

Copy the files in the IBM-Hotfixes\features directory to the UpdateSite\features directory.

If the client platforms at the site do not all use the same operating system, we recommend that you create
a separate UpdateSite directory for each operating system and copy the IBM hotfixes for each operating
system into the applicable UpdateSite directory.

Copy the files in the IBM-Hotfixes\plugins directory to the UpdateSite\plugins directory.
Replace the site.xml file in the UpdateSite directory with the site.xml file in the IBM-Hotfixes directory.

A

Caution  You must replace the site.xml file before configuring Cisco Unified Messaging with IBM
Lotus Sametime by using the Configuration Tool. Otherwise, the IBM hotfixes for secure
messaging will not be available for installation.
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Upgrading to Cisco Unified Messaging with IBM Lotus Sametime 7.1(1)

There is no separate upgrade process—you install the new version of the plug-in in the same way you
installed the previous version. See the next section, “Installing Cisco Unified Messaging with IBM Lotus
Sametime 7.1(1).”

You do not need to uninstall a previous version. The update manager in Sametime handles it.

Installing Cisco Unified Messaging with IBM Lotus Sametime 7.1(1)

There are two ways in which to install the plug-in on user workstations:

e Automatic push update—See the IBM Lotus Sametime documentation for information on setting
up an automatic push update. We recommend using this method.

e Manual installation—Do the “To Manually Install the Cisco Unified Messaging with IBM Lotus
Sametime Plug-in on a User Workstation” procedure on page 8.

Note  After the plug-in is installed, users may be required to enter their Cisco Unity or Cisco Unity Connection
account information in their IBM Lotus Sametime client application. Instructions are provided in the
User Guide for Cisco Unified Messaging with IBM Lotus Sametime Release 7.x, available on Cisco.com
at http://www.cisco.com/en/US/products/ps9830/products_user_guide_list.html.

To Manually Install the Cisco Unified Messaging with IBM Lotus Sametime Plug-in on a User Workstation

Step1  Start the IBM Lotus Sametime client application.
Step2  From the Tools menu, select Plug-ins > Install Plug-ins.

Step3  In the Install/Update wizard, on the Feature Updates page, select Search for New Features to Install
and select Next.

Step4  On the Update Sites to Visit page, select the applicable option to add an update site:

IBM Lotus Sametime 8.x Select Add Remote Location.

IBM Lotus Sametime version 7.5.1 CF1 |Select New Remote Site.

Step 5 In the New Update Site dialog box, in the Name field, enter Cisco Voicemail.

Step6  In the URL field, enter the URL of the update site that hosts the Cisco Unified Messaging with IBM
Lotus Sametime plug-in and select OK.

Step7  On the Update Sites to Visit page, select Finish.
The Updates window opens with Cisco Voicemail listed as a feature to install.
Step8  Select Cisco Voicemail.
Step 9 If there is an IBM hotfix available, select the IBM hotfix.
Step10  Select Next.
Step11  Select I Accept the Terms of the License Agreement and select Next.

Step12 If a feature verification warning appears, select Install All.
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Select Yes to restart the IBM Lotus Sametime client application.

Configuring Cisco Unified Messaging with IBM Lotus Sametime 7.1(1)

Step 1

Step 2
Step 3
Step 4

Step 5
Step 6

In this section, you configure the Cisco Unified Messaging with IBM Lotus Sametime plug-in for all
users who will use it.

You can use the Cisco Unified Messaging with IBM Lotus Sametime Configuration Tool for updating
user configuration information after the plug-in has been installed.

For configuration changes to take effect, either set up IBM Lotus Sametime to update users automatically
by using a push update, or instruct users to update the plug-in from their IBM Lotus Sametime client.

This section contains two procedures:
¢ To Configure Cisco Unified Messaging with IBM Lotus Sametime by Using the Configuration Tool
e To Manually Configure Cisco Unified Messaging with IBM Lotus Sametime on a User Workstation

To Configure Cisco Unified Messaging with IBM Lotus Sametime by Using the Configuration Tool

Go to directory that was created in the “To Download Cisco Unified Messaging with IBM Lotus
Sametime 7.1(1)” procedure on page 6.

Go to the ciscocfg directory.
Double-click ciscocfg.exe.

In the Choose an Update dialog box, in the Directory field, enter the path of the UpdateSite directory
that was created in the “To Download Cisco Unified Messaging with IBM Lotus Sametime 7.1(1)”
procedure on page 6.

Select OK.

In the Cisco Unified Communications with IBM Lotus Sametime Configuration Tool window, click the
LDAP tab and enter values in the applicable fields. The fields are described in Table 1.

It is not mandatory to enter the settings in these fields.

Table 1 Fields on the LDAP Tab

Name Description

Directory Server Settings

Server Enter the name or IP address of the LDAP server.

Port Enter the number of the port used to communicate with the LDAP
server.

Search Base Enter the base (or root) of the directory service in which to search

for names. The value must match the one configured on Sametime
server. If LDAP is used for the directory service, you can derive
the setting directly from there. If Domino is used instead, find the
equivalent search base on its LDAP interface.

Display Name Attribute Enter the LDAP attribute that is used as the display name for the
caller.
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Table 1 Fields on the LDAP Tab (continued)

Description

Attribute for Lookup in Sametime

Enter the LDAP attribute that is used to search for the caller in
Sametime.

Authentication Required

Check this option if authentication is required by the server.

Authentication Credentials

Distinguished Name

(When authentication is enabled) Enter the distinguished name
that is used to authenticate with the directory service.

Password

(When authentication is enabled) Enter the password that is used
to authenticate with the directory service.

Directory Usage

Non-default Community Access

Enable non-default communities to use directory services to
extend the functions to pilot communities, for example:

e Retrieve phone numbers to populate their contacts
e Show phone status for their contacts

Only one set of users data can be used. You can have two
communities, but of the same global set of users. If the Sametime
server for the non-default communities uses the same LDAP
server as the default community, then identical functionality can
be extended to contacts in those communities.

Select the applicable setting:

e Disable—Select this option so that non-default communities
are unable to use the directory service.

¢ Enable for All Communities—Select this option so that all
non-default communities are allowed to use the directory
service.

¢ Enable for Configured Communities—Select this option
so that only communities listed in the Community List field
are allowed to use the directory service.

Community List

(When Enable for Configured Communities is selected above)
Enter the list of communities (Sametime host name or IP
address), separated by commas, that you want to allow access to
the directory service.

Directory Type for Sametime Server

Directory Type

Enter the applicable settings:

LDAP—Select this option if the IBM Lotus Sametime server
uses an LDAP server for directory service.

If IBM Lotus Sametime uses an LDAP attribute for the internal
user ID, check the Use Attribute as Internal ID of Sametime
User option and enter the name of the LDAP attribute.

Domino—Select this option if the IBM Lotus Sametime server
uses IBM Lotus Domino for the directory service.

Refer to IBM Lotus Sametime documentation for additional
information.
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Table 1 Fields on the LDAP Tab (continued)

Name Description

Dialing Rules Files

Application Dial Rules If you will use Application Dial Rules, enter the location of the
dial rules file. You can obtain Application Dial Rules from the
Cisco Unified Communications Manager administrator web page
by navigating to the Call Routing area.

Application Dial Rules automatically strip numbers from or add
numbers to telephone numbers that Sametime Connect dials. For
example, the dialing rules automatically add the digit 9 in front of
a 7-digit telephone number to provide access to an outside line.

Note A file template is available in the templates directory
where you extracted the Cisco Unified Messaging with
Lotus Sametime Configuration Tool.

This field applies only when Cisco Phone Control and
Presence is configured with Cisco Unified Messaging
with IBM Lotus Sametime.

Directory Lookup Dial Rules If you will use Directory Lookup Dial Rules, enter the location of
the dial rules file. You can obtain Directory Lookup Dial Rules
from the Cisco Unified Communications Manager administrator
web page. Navigate to the Call Routing area.

Directory Lookup Dial Rule transform caller identification
numbers into numbers that can be looked up in the directory. For
example, the dialing rules can automatically add +140852 to
5-digit numbers beginning with 5, so that the number 56666
becomes +14085256666.

Note A file template is available in the templates directory
where you extracted the Cisco Unified Messaging with
Lotus Sametime Configuration Tool.

Step 7 On the File menu in the Configuration Tool window, select Save.

Step 8 In the Cisco Unified Communications with IBM Lotus Sametime Configuration Tool window, select the
Voicemail tab and enter values in the applicable fields. The fields are described in Table 2.

Fields that remain empty do not overwrite the Cisco Unified Messaging with IBM Lotus Sametime
configuration on the client, but fields with values will overwrite the Cisco Unified Messaging with IBM
Lotus Sametime configuration when an updated feature is installed on the client workstation.
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Table 2 Fields on the Voicemail Tab

Name

Description

Mail Store Connection Settings

Server Enter the applicable setting:
e For Cisco Unity, enter the name or IP address of the
Exchange or IBM Lotus Domino server.
e For Cisco Unity Connection, enter the name or IP address of
the Connection server.
Port Enter the number of the port used to communicate with the mail

store.

Note Cisco Unity Connection provides a port that enables
license-free IMAP connections. To use this port, enter
7993, and check the Use Encrypted Connection check
box.

Use Encrypted Connection

Check this check box to use an encrypted connection to
communicate with the mail store.

Use Sametime Credentials

Check this check box if the credentials for logging in users to
IBM Lotus Sametime are the same as the credentials for
connecting to the voicemail system.

Read Only

Check this check box to prevent the user from changing these
settings.

Poll Interval

If the server supports IMAP IDLE, the setting in this field is
ignored.

If the server does not support IMAP IDLE, enter the time, in
seconds, that each client waits before checking for new voice
messages.

Mail Store Folder Settings

Inbox Folder

Enter the name of the voicemail folder in the IMAP store.

Move Deleted Voicemail to a
Separate Folder

Check this check box if the mail store has a folder for deleted
messages that is separate from the Inbox folder.

Trash Folder

If the mail store has a separate folder for deleted messages, enter
the name of the folder for deleted messages.

System Settings

Enable Connection to Voicemail
Web Service Server

If secure messaging is configured on Cisco Unity, check this
check box to enable the Voicemail Web Service server.

If secure messaging is configured on Cisco Unity Connection, do
not check this check box.

Use Mail Store Server as Voicemail
Web Service Server

(When the Voicemail Web Service server is enabled) Check this
check box if the Voicemail Web Service server is on the mail store
server that is entered in the Servers field under Mail Store
Connection Settings.
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Step 10

Step 11
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Table 2 Fields on the Voicemail Tab (continued)
Name Description
Server (When the Voicemail Web Service server is enabled) If the Use

Mail Store Server as Voicemail Web Service Server check box is
not checked, enter the name or IP address of the Voicemail Web
Service server.

Protocol (When the Voicemail Web Service server is enabled) Select the
applicable setting:
e HTTP—Select this option if message security is not used.
e HTTPS—Select this option if message security is used.
Port (When the Voicemail Web Service server is enabled) Enter the

number of the port used to communicate with the Cisco Unity
Sserver.

LDAP Attributes

User ID

Enter the LDAP user attribute that contains the user ID in voice
messages so that a directory search can find and display the user
name.

Phone Numbers

Enter the LDAP phone attributes that contain the caller ID in
voice messages so that a directory search can replace the phone
number with the caller name on voicemail.

Voicemail Player Settings

Rewind Interval

Enter the time, in seconds, that a message will rewind when the
Rewind button on the Voicemail player is pressed.

Skip Forward Interval

Enter the time, in seconds, that a message will skip forward when
the Skip Ahead button on the Voicemail player is pressed.

Logging

Enable Detailed Logging

Check this check box to enable detailed logging.

A

Caution  Enable detailed logging only for troubleshooting.
Otherwise, the logging will impact the system
performance.

On the File menu in the Configuration Tool window, select Save All.

On the File menu in the Configuration Tool window, select Exit.

A

Caution  Confirm that you have saved your changes in the Cisco Unified Communications with IBM
Lotus Sametime Configuration Tool window. Otherwise, all unsaved changes will be lost
when you close the window.

For configuration changes to take effect, either set up IBM Lotus Sametime to automatically update users
by using a push update, or instruct users to update the plug-in from their IBM Lotus Sametime client.
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~

Note

Step 1

Step 2

If your users want IBM Lotus Sametime to display the date in a format for English other than U.S.
English, do the following procedure. Otherwise, skip to the “To Manually Configure Cisco Unified
Messaging with IBM Lotus Sametime on a User Workstation” procedure on page 15.

The following procedure applies only to IBM Lotus Sametime installed on the Windows Vista, Windows
XP, or Mac operating systems. This workaround does not apply to IBM Lotus Sametime installed on a
Linux operating system, or to IBM Lotus Notes.

To Configure IBM Lotus Sametime to Display the Date in a Non-U.S. English Format

On the user workstation, go to the applicable directory and open the applicable file.

Table 3

Location of the File for Displaying the Date in a Non-U.S. English Format

IBM Lotus Sametime

Version Operating System |Path and File

7.5.1 Windows Vista <IBM Lotus Sametime Installation
Windows XP directory>\IBM\Sametime Connect\sametime.ini
Mac Applications/sametime/Sametime.ini

8.0 or later Windows Vista <disk>\Documents and Settings\<user>\Application
Windows XP Data\Lotus\Sametime\.config\rcpinstall.properties
Mac Users/<user>/Lotus/Sametime/.config/

rcpinstall.properties

In the file that you opened in Step 1, make the following change.

Table 4

Change to the File for Displaying the Date in a Non-U.S. English Format

IBM Lotus Sametime

Version

Operating System

Change in the File

7.5.1

Windows Vista

Change the line -Dosgi.nl=en to one of the following:

Windows XP e For Canada, enter -Dosgi.nl=en_CA.

e For Ireland, enter -Dosgi.nl=en_IE.

e For United Kingdom, enter -Dosgi.nl=en_GB.
Mac At the end of the file, add the applicable line.

e For Canada, enter -Dosgi.nl=en_CA.
e For Ireland, enter -Dosgi.nl=en_IE.

e For United Kingdom, enter -Dosgi.nl=en_GB.
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Table 4 Change to the File for Displaying the Date in a Non-U.S. English Format (continued)

IBM Lotus Sametime

Version Operating System |Change in the File
8.0 or later Windows Vista Change the line com.ibm.rcp.core.locale=en to one of
Windows XP the following:

e For Canada, enter com.ibm.rcp.core.locale=en_CA.
e For Ireland, enter com.ibm.rcp.core.locale=en_IE.

e For United Kingdom, enter
com.ibm.rcp.core.locale=en_GB.

Mac At the end of the file, add the applicable line:
e For Canada, enter com.ibm.rcp.core.locale=en_CA.
e For Ireland, enter com.ibm.rcp.core.locale=en_IE.

e For United Kingdom, enter
com.ibm.rcp.core.locale=en_GB.

Step3  Save and close the file.
The following procedure requires administrator-provided information.
To Manually Configure Cisco Unified Messaging with IBM Lotus Sametime on a User Workstation

Step 1 In IBM Lotus Sametime Connect, on the File menu, click Preferences.

Step 2 In the Preferences window, in the left pane, expand Cisco and select Voicemail.

Step3  Under Account, if the following fields are blank, enter the applicable settings as your administrator
instructs. Otherwise, continue to Step 4.
a. In the User ID field, enter your user ID.
b. In the Password field, enter your password.
c. In the Server field, enter the server name or the IP address of the mail store.
d. In the Port field, enter the port number used to communicate with the mail store.
e. Check or uncheck the Use Secure Connection check box.

Step4  If you want Sametime to display an icon indicating unheard voice messages, check the Show Global
Message Waiting Indicator check box.

Step5 If you want Sametime to maintain a log to assist in troubleshooting issues, check the Enable Detailed
Logging check box.

Step6  Select OK to accept the settings and to close the Preferences window.
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[ oL-18982-m .-m



B Limitations and Restrictions

Limitations and Restrictions

IBM Lotus Notes Displays Dates In U.S. English Format

IBM Lotus Notes displays dates only in the U.S. English format when any English language is selected.

G.729a Encoded Voice Messages Cannot Be Played

Cisco Unified Messaging with IBM Lotus Sametime plays only voice messages encoded with G.711.

MWI on Phone Does Not Change to Reflect Message State

For environments with Cisco Unity and IBM Lotus Domino as the message server, IBM Lotus Sametime
does not communicate changed message states so that Cisco Unity can change the message waiting
indicator (MWI) on the phone. For example, the new-message light on the phone will not turn off after
the message is played from IBM Lotus Sametime.

Deleted Message Folder Is Not Supported If the Mail Store Does Not Support
UIDPLUS

If the mail store does not support UIDPLUS, Cisco Unified Messaging with IBM Lotus Sametime does
not support a folder for deleted messages that is separate from the Inbox folder. Voicemail in a folder for
deleted messages on this message store has the following limitations:

e Moving voice mail to a folder for deleted messages does not turn off MWIs.

e IBM Lotus Sametime Connect shows the deleted voicemail by using the Deleted filter, but the
telephone user interface (TUI) lists the deleted voicemail as saved messages.

e Voicemail in the folder for deleted messages cannot be deleted or purged.

Update Sites

IBM Lotus Sametime does not support simultaneous updates from multiple update sites. Selecting more
than one update site and trying to install a feature will cause a NullPointerException.

Caveats

This section lists any Severity 1, 2, or 3 caveats for this release.

You can find the latest caveat information for Cisco Unified Messaging with IBM Lotus Sametime—in
addition to caveats of any severity for any release—by using Bug Toolkit, an online tool available for
customers to query defects according to their own needs. Bug Toolkit is available at
http://www.cisco.com/go/bugs.

Release Notes for Cisco Unified Messaging with IBM Lotus Sametime Release 7.1(1)
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Troubleshooting Information W

Note

To access Bug Toolkit, you must be logged on to Cisco.com as a registered user.

This section contains caveat information for Cisco Unified Messaging with IBM Lotus Sametime
Release 7.1(1) only. Refer to the release notes of the applicable version for caveat information in earlier
versions. Release notes for all versions of Cisco Unified Messaging with IBM Lotus Sametime are
available at http://www.cisco.com/en/US/products/ps9830/prod_release_notes_list.html and are listed
as the product “Cisco Unified Communications - Enterprise.”

Open Caveats—Release 7.1(1)

Select the link in the Caveat Number column to view the latest information on a caveat in Bug Toolkit.
(Caveats are listed in order by severity, then by component, then by caveat number.)

Table 5 Cisco Unified Messaging with IBM Lotus Sametime Release 7.1(1) Open Caveats

Caveat Number |Severity |Component |Description

CSCsi80650 3 voicemail [UNITY/DOMINO] Deskphone MWI not in sync with changes made from
plug-in

CSCsj51224 3 voicemail Connection 2.0 CO-RES plug-in deleted msg not purged when hardphone was

CSCsk45445 3 voicemail [MAC/ST 7.5.1]Autopush doesn't work when permission not set

CSCsk47107 3 voicemail Plug-in won't play private message in Connection 2.0

CSCsk64062 3 voicemail [MAC/ST 751] Sametime crashes changing preferences and clicking
Apply/OK

CSCsk86913 3 voicemail ST 7.5.1] Manual install via Tools > Plug-ins... does not work on Vista

CSCsl124273 3 voicemail [VISTA] Manual install/uninstall fails when Vista user password set

Resolved Caveat—Release 7.1(1)

Select the link in the Caveat Number column to view the latest information on a caveat in Bug Toolkit.

Table 6 Cisco Unified Messaging with IBM Lotus Sametime Release 7.1(1) Resolved Caveat
Caveat Number Severity |Component Description
CSCsy34016 3 voicemail Incorrect MWI Status on forwarded message when logged into Sametime

Troubleshooting Information

e Status Bar in Cisco Voicemail Application Panel, page 18

e Creating a Problem Report, page 18

e User Unable to Play Voice Messages Because of Port Conflicts, page 18
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W Troubleshooting Information

Status Bar in Cisco Voicemail Application Panel

The status bar at the bottom of the Cisco Voicemail application panel indicates when the user is
successfully connected to Cisco Unity or to Cisco Unity Connection. Any error messages appear as
hypertext links, which users can select to show information about the errors and how to resolve them.

Creating a Problem Report

Step 1

Step 2
Step 3
Step 4

If any unexpected or unresolvable issues occur, detailed logging information is available that can assist
in troubleshooting.

To Create a Problem Report

Locate your IBM Lotus Sametime logs files:

a. From the File menu, select Preferences.

b. Open the Cisco tab on the left.

¢. Under Cisco, select the Voicemail tab.

The Logs field shows the location of the IBM Lotus Sametime logs.

On the preference page, check the Enable Detailed Logging check box.

Reproduce the problem, then select Create Problem Report to collect the log files.
When prompted, enter the directory in which you want the problem report saved.

At this location, the problem report will be saved with a filename in the following format:

ProblemReport_Voicemail_<version>_<user ID>_<timestamp>.zip

User Unable to Play Voice Messages Because of Port Conflicts

If a user is unable to play a voice message and receives an “Error attempting to play voicemail” or
“Unable to instantiate Audio Player” message, check the applicable log file:

e For IBM Lotus Notes, go to the trace-log-0.xml file.
e For IBM Lotus Sametime version 8.0 or later, go to the trace-log-0.xml file.
e For IBM Lotus Sametime version 7.5.1, go to the Sametime.log.0 file.
If the log file shows a bind exception, then the Voicemail Port may be in use by another plug-in.

To resolve this problem, change the Voice Chat Port number from the Sametime Administration Console

on the Sametime server. For steps on how to change this port, refer to the Sametime Administrator Guide.
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Obtaining Documentation and Submitting a Service Request ||

Obtaining Documentation and Submitting a Service Request

For information on obtaining documentation, submitting a service request, and gathering additional
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed
and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free
service and Cisco currently supports RSS version 2.0.

CCDE, CCSI, CCENT, Cisco Eos, Cisco HealthPresence, the Cisco logo, Cisco Lumin, Cisco Nexus, Cisco Nurse Connect, Cisco Stackpower,
Cisco StadiumVision, Cisco TelePresence, Cisco WebEx, DCE, and Welcome to the Human Network are trademarks; Changing the Way We Work,
Live, Play, and Learn and Cisco Store are service marks; and Access Registrar, Aironet, AsyncOS, Bringing the Meeting To You, Catalyst, CCDA,
CCDP, CCIE, CCIP, CCNA, CCNP, CCSP, CCVP, Cisco, the Cisco Certified Internetwork Expert logo, Cisco I0S, Cisco Press, Cisco Systems,
Cisco Systems Capital, the Cisco Systems logo, Cisco Unity, Collaboration Without Limitation, EtherFast, EtherSwitch, Event Center, Fast Step,
Follow Me Browsing, FormShare, GigaDrive, HomeLink, Internet Quotient, IOS, iPhone, iQuick Study, IronPort, the IronPort logo, LightStream,
Linksys, MediaTone, MeetingPlace, MeetingPlace Chime Sound, MGX, Networkers, Networking Academy, Network Registrar, PCNow, PIX,
PowerPanels, ProConnect, ScriptShare, SenderBase, SMARTnet, Spectrum Expert, StackWise, The Fastest Way to Increase Your Internet Quotient,
TransPath, WebEx, and the WebEx logo are registered trademarks of Cisco Systems, Inc. and/or its affiliates in the United States and certain other
countries.

All other trademarks mentioned in this document or website are the property of their respective owners. The use of the word partner does not imply
a partnership relationship between Cisco and any other company. (0903R)

Any Internet Protocol (IP) addresses used in this document are not intended to be actual addresses. Any examples, command display output, and
figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses in illustrative content is unintentional and
coincidental.

© 2009 Cisco Systems, Inc. All rights reserved.
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